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INSTALLATION GUIDE

BNC/TC-2095 Rack-Mount Adapter
This installation guide describes how to install the National Instruments 

BNC-2095 and the TC-2095 rack-mount adapters and use them with 

SCXI-1100, SCXI-1102/B/C, and SCXI-1104/C modules. The BNC-2095 

also can be used with the SCXI-1581.

The BNC-2095 adapter has 32 BNC connectors to connect field signals to 

the SCXI module inputs. The TC-2095 adapter has 32 uncompensated 

miniconnectors to connect the thermocouples to the SCXI module inputs. 

Both the BNC-2095 and TC-2095 adapters have the following features:

• A 96-pin connector to connect to the SCXI module using an SH96-96 

shielded cable or an R9696 ribbon cable

• Rack-mount construction for use with 19-in. racks

• A shielded, metal enclosure to minimize noise

The TC-2095 also features isothermal construction to minimize the 

temperature gradients across the thermocouple junctions and a 

high-accuracy thermistor for cold-junction temperature sensing.

The BNC-2095 and the TC-2095 have pull-up resistors connected between 

CH+ and +5 VDC and ground-referencing resistors connected between 

CH– and chassis ground through switches located on the rear of the adapter. 

The bias resistor is a ground-referencing pull-down resistor for referencing 

floating signals; the pull-up resistor is used for open thermocouple 

detection. The pull-up resistors enable open thermocouple detection by 

detecting saturation in the SCXI module amplifier output and 

ground-referenced floating signals.
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Conventions

The following conventions are used in this guide:

♦ The ♦ symbol indicates that the text following it applies only to a specific 

product, a specific operating system, or a specific software version.

<> Angle brackets that contain numbers separated by an ellipsis represent a 

range of values associated with a bit or signal name—for example, 

DBIO<3..0>. Angle brackets also can denote a variable in a channel 

name—for example, ACH<i>.

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this symbol is marked on 

the product, refer to the Read Me First: Safety and Radio-Frequency 

Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product it denotes a warning advising you to 

take precautions to avoid electrical shock.

When symbol is marked on a product it denotes a component that may be 

hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names and hardware labels.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames and extensions, and code excerpts.
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What You Need To Get Started

To install and use the BNC/TC-2095, you need the following items:

❑ One of the following:

– BNC-2095 rack-mount adapter with BNC connectors

– TC-2095 rack-mount adapter with thermocouple miniconnectors

❑ BNC/TC-2095 Rack-Mount Adapter Installation Guide

❑ Read Me First: Safety and Radio-Frequency Interference

❑ Four 10 MΩ resistor networks

❑ SCXI chassis and documentation

❑ One of the following SCXI modules and its documentation:

– SCXI-1100

– SCXI-1102/B/C

– SCXI-1104/C

– SCXI-1581

❑ One of the following cable assemblies:

– SH96-96 cable assembly (recommended)

– R9696 cable assembly

❑ TBX cable adapter (included in cable assembly kit)

❑ Number 1 Phillips screwdriver

❑ 1/8 in. flathead screwdriver

❑ Long-nose pliers

Connecting Signals

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 

before removing equipment covers or connecting/disconnecting any signal wires.

This section describes how to connect field signals to the adapter and how 

to connect the adapter to the SCXI module.
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Connecting Field Signals

♦ BNC-2095

The BNC-2095 has 32 BNC connectors, one for each channel of a 

SCXI module. Each BNC connector is labeled with the corresponding 

channel number. The center pin of the BNC connector is the CH+, and 

the outer shield is the CH– of each channel. The CH– is isolated from 

the chassis ground, so you can use it for ground-referenced differential 

signals. To ensure CH– is isolated from chassis ground, do not use bias 

resistors.

Caution Do not force the BNC connector on the BNC-2095. If you have difficulty making 

the connection, completely remove the connector and try again.

Connect the BNC connector of the cable to the BNC connector of the 

BNC-2095 by aligning and inserting the connector and turning the 

cable connector clockwise.

♦ TC-2095

The TC-2095 has 32 universal thermocouple miniconnectors that you 

can use to connect a thermocouple to each channel of the SCXI 

module. Each connector is labeled with the corresponding channel 

number. The miniconnector indicates the positive and negative 

terminals.

Caution Do not force the miniconnector into the socket. If you have difficulty inserting the 

miniconnector, check that the polarity is correct.

Connect the thermocouple wire to the TC-2095 by inserting the 

miniconnector into the socket. Each miniconnector consists of two 

spades of different widths. The differing widths guarantee correct 

polarity if both connectors are correctly wired.

Both contacts of the thermocouple miniconnector are made of copper. 

This could cause offset errors in T-, R-, and S-type thermocouple 

measurements because each of these types of thermocouples has 

one copper contact. Only one contact forms a cold junction with 

T, R, and S-type thermocouples.
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Configuring Open-Thermocouple/Signal Detection and Signal 
Ground-Referencing

Refer to Table 1 to configure the BNC/TC-2095 for operating with 

open-thermocouple or signal detection, and for properly 

ground-referencing the signals.

Table 1.  Configuring Open-Thermocouple/Signal Detection and Signal Ground-Referencing

Switch Settings Signal Type

Detects

Open 

Thermocouple Comments

Floating signal or 

thermocouple

Yes BNC-2095—Use this 

setting for detecting 

floating signals or open 

signal leads. When 

detecting open signal 

leads, the positive input is 

pulled to +5 VDC if the 

measured signal is 

<5 VDC. Only use this 

setting or configuration 

with signals between 

±5 VDC.

TC-2095—Use this setting 

to detect open 

thermocouples and when 

the thermocouple is 

floating.

Ground-referenced

signal or 

thermocouple

No BNC-2095 or 

TC-2095—Use this setting 

when the signal or 

thermocouple is 

ground-referenced and 

you want to disable 

open-thermocouple 

detection.

1
ON

2
3

4
5

6
7

8

GND REF

C
H

O
F

F

O
N

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP
3

2

1

0

1
ON

2
3

4
5

6
7

8

GND REF

C
H

O
F

F

O
N

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP
3

2

1

0
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Caution Connecting an external ground-referenced signal with the 10 Ω resistor network 

in place can cause permanent damage to the resistor network and the traces on the 

BNC/TC-2095 printed circuit board. NI is not liable for any damage or injuries resulting 

from improper signal connections. Refer to the Temperature Sensor Output and Accuracy 

section for more information.

Connecting the BNC/TC-2095 to the SCXI Module
Complete the following steps to mount the SH96-96 cable assembly and 

connect the BNC/TC-2095 to the SCXI module. Refer to Figures 1 and 2 

as needed.

Floating 

thermocouple or 

signal

No BNC-2095 or 

TC-2095—Use this setting 

when the signal or 

thermocouple is floating 

and you want to disable 

open-thermocouple 

detection.

Ground-referenced

thermocouple or 

signal

Yes BNC-2095—Use this 

setting for detecting 

ground-referenced signals 

or open signal leads. 

When detecting open 

signal leads, the positive 

input is pulled to +5 VDC 

if the measured signal is 

<5 VDC. Only use this 

setting or configuration 

with signals between 

±5 VDC.

TC-2095—Use this setting 

to detect open 

thermocouples for 

ground-referenced 

thermocouples.

Table 1.  Configuring Open-Thermocouple/Signal Detection and Signal Ground-Referencing (Continued)

Switch Settings Signal Type

Detects

Open 

Thermocouple Comments

1
ON

2
3

4
5

6
7

8

GND REF

C
H

O
F

F

O
N

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP
3

2

1

0

1
ON

2
3

4
5

6
7

8

GND REF

C
H

O
F

F

O
N

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP

GND REF

PULL-UP
3

2

1

0
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Caution Refer to the Connecting Signals section before connecting the signals. If signal 

wires are connected to the terminal block, dangerous voltages can exist even when the 

equipment is powered off.

1. Power off the SCXI chassis.

2. Power off the computer that contains the E Series data acquisition 

(DAQ) device, or disconnect the computer from the SCXI chassis.

3. Connect the TBX cable adapter to the SCXI module, and secure the 

adapter by tightening both thumbscrews.

4. Connect either end of the SH96-96 cable to the TBX cable adapter and 

SCXI module, and secure the cable by tightening both backshell 

mounting screws.

Figure 1.  Connecting the SH96-96 Cable to the SCXI Module

5. Mount the BNC/TC-2095 onto a 19-in. rack or place it on a workbench 

near the SCXI chassis. If you do not rack-mount the BNC/TC-2095, 

attach the four adhesive rubber feet included in the kit to the bottom of 

the adapter to keep it stationary.

1 Backshell Mounting Screws
2 SH96-96 Cable

3 Thumbscrews
4 SCXI Chassis

5 TBX Cable Adapter

3

4

3

1

5
1

2

5
4
3
2
1

A
D

D
R

E
S

S
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Note To minimize the temperature gradient inside the TC-2095 and maintain its 

isothermal properties for accurate cold-junction compensation, keep the adapter from 

extreme temperature differentials.

6. Connect the other end of the 96-pin cable to the BNC/TC-2095 96-pin 

connector and screw down the backshell.

Caution The cable connectors of the cables are keyed. Do not force the connection. If you 

encounter difficulty, verify that the keying of the cable connectors is correct.

Figure 2.  BNC/TC-2095 Connected to SCXI Module

Configuring the BNC/TC-2095

To access jumpers W1 and W2 and the resistor networks, refer to Figure 3 

as you complete the following steps:

1. Remove the nine cover screws that secure the BNC/TC-2095 cover.

2. Remove the cover.

3. Set jumpers W1 and W2 as needed. For more information about setting 

the jumpers, refer to the Configuring the Shield Ground Jumper and 

Configuring the Cold-Junction Sensor (TC-2095 Only) sections.

4. Replace the cover and secure it with the cover screws.

1 BNC/TC-2095 2 96-Pin Backshell 3 SCXI Chassis

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1
O
N

2
3

4
5

6
7

8

1

5
4
3
2
1

A
D

D
R

E
S

S

2 32
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Figure 3.  BNC-2095 Parts Locator Diagram

Configuring the Shield Ground Jumper
Jumper W2 connects the metal case and shield to the analog ground of the 

SCXI module directly or through a 100 Ω resistor. The factory-default 

setting is through the 100 Ω resistor. Refer to Table 2 for configuration 

options for jumper W2.

1) Cover
2) Cover Screws (9)
3) RP1
4) RP5
5) RP2

6) RP5
7) W1
8) W2
9) RP3
10) RP7

11) RP4
12) RP8
13) Switches

12
11

10
9

8
7

6
5

4
3

13

2

1
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Table 2.  BNC/TC-2095 Shield Ground Jumper Configuration

Jumper W2 Configuration Description When to Use a Setting

100 Ω (factory-default)— 

Connects the 

BNC/TC-2095 housing 

to SCXI chassis ground 

through a 100 Ω resistor, 

while minimizing any 

potential ground loop 

current.

Use this setting when you are using 

the SH96-96 cable, and if one of the 

following is true:

• You have not rack-mounted the 

BNC/TC-2095.

• You have rack-mounted the 

BNC/TC-2095, but are unsure 

whether the rack and the 

BNC/TC-2095 are grounded.

0 Ω—Connects the 

BNC/TC-2095 housing to 

SCXI chassis ground.

Use this setting only if the 

factory-default setting is inadequate 

for noise rejection, you are using the 

R9696 cable, and if one of the 

following is true:

• You have not rack-mounted the 

BNC/TC-2095.

• You have rack-mounted the 

BNC/TC-2095 and are sure that 

the rack and the BNC/TC-2095 

are not grounded.

Open—Disconnects the 

BNC/TC-2095 metal 

housing from SCXI 

chassis ground.

Use this setting only if all of the 

following are true:

• Factory-default setting was 

inadequate for noise rejection.

• You are using either the SH96-96 

cable or the R9696 cable.

• You have rack-mounted the 

BNC/TC-2095.

• You are sure that the rack and the 

BNC/TC-2095 are grounded.

0 Ω

100 Ω

OPEN

4
3

2
1

W
2

0 Ω

100 Ω

OPEN

4
3

2
1

W
2

0 Ω

100 Ω

OPEN

4
3

2
1

W
2
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Configuring the Cold-Junction Sensor (TC-2095 Only)

The TC-2095 jumper W1 is set by factory-default to multiplexed 

temperature sensor (MTEMP) mode. This setting multiplexes the 

cold-junction sensor for SCXI modules operating in multiplexed mode. 

Refer to Figure 3 for the location of jumper W1.

Do not change the factory-default position of jumper W1.

Table 3 shows the jumper W1 settings.

Temperature Sensor Output and Accuracy
The TC-2095 temperature sensor voltage output varies from 1.91 to 

0.58 VDC over the 0 to 55 °C temperature range. Table 4 shows the 

temperature sensor output accuracy.

To select and read the temperature sensor, refer to the driver software 

documentation for programming information.

Table 3.  Jumper W1 Settings for the TC-2095

Jumper W1 Position Description

MTEMP (CJTEMP) 

mode—Factory-default setting. 

Do not change the jumper 

position.

Table 4.  Temperature Sensor Voltage Output Accuracy

Temperature Range Voltage Output Accuracy1

0 to 15 °C ±1.0 °C

15 to 35 °C ±0.65 °C

< 35 to 55 °C ±1.0 °C

1 Includes the combined effects of the temperature sensor accuracy and the temperature 

difference between the temperature sensor and any screw terminal. The terminal sensor 

accuracy includes tolerances in all component values, the effects caused by temperature 

and loading, and self-heating.

W
1

MTEMP

DTEMP
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Alternatively, you can follow these steps to convert the cold-junction sensor 

voltage to the cold-junction temperature.

1. Calculate the resistance of the thermistor in Ω.

VTEMPOUT = output voltage of the temperature sensor

Note VTEMPOUT varies from 1.91 VDC (at 0 °C) to 0.58 VDC (at 55 °C). For the best 

resolution, use the maximum gain for this signal range on the analog input channel of the 

E Series DAQ device.

The SCXI-1100 does not have a filter on the VTEMPOUT signal. Therefore, use an average of 

a large number of samples to obtain an accurate measurement. For example, sample for 

one second and average. Noisy environments require more samples for greater accuracy.

The SCXI-1102/B/C has a 2 Hz filter on the VTEMPOUT signal input channel.

2. Calculate the cold-junction temperature in Kelvin.

a = 1.295361 × 10–3

b = 2.343159 × 10–4

c = 1.018703 × 10–7

RT = resistance of the thermistor

3. Convert the temperature to Celsius and Fahrenheit.

TK = temperature in Kelvin

where T(°F) and T(°C) are the temperature readings in degrees 

Fahrenheit and Celsius, respectively.

R
T

5,000
V
TEMPOUT

2.5 V
TEMPOUT

–
---------------------------------------
 
 =

T
K

1

a b Rln
T

( ) c Rln
T

( )
3

+ +

--------------------------------------------------------------=

T °C( ) T
K
273.15–=

T °F( )
T °C( )[ ]9

5
----------------------- 32+=
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Temperature Sensor Circuit Diagram
The circuit diagram in Figure 4 is optional information that you can use if 

you want more details about the TC-2095 temperature sensor.

Figure 4.  Temperature Sensor Circuit Diagram

Configuring the Resistor Networks

When using an SCXI-1102/B/C, you can use the package of 10 MΩ resistor 

networks included in the BNC/TC-2095 kit. You can install these resistor 

networks as RP1, RP2, RP3, and RP4. Refer to Figure 3 for the locations 

of RP<1...8>. If you use this configuration and you have the 

ground-referencing switch powered on, the thermocouples or signals with 

low-impedance sources (less than 100 Ω) either float without affecting the 

measurement or are ground-referenced.

Figure 5 shows how the pull-up and ground-referencing resistors are 

connected to the CH± inputs of the SCXI module.

4.7 kΩ 
1%

5 kΩ

0.1%

1

2

1

2

2

+5 kΩ 
at 25 °C

10 µF
16 V

0.1 µF

0.1 µF

–t°

+5 V

2.5 V

LM 4040
2.5 V
0.1%

MTEMP

DTEMP

W1
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Figure 5.  Resistor Connections

Table 5 shows which resistors are associated with each group of channels.

SCXI-1102/B/C Module
You can replace the 10 Ω ground-referencing resistor networks 

(factory-default configuration) in the BNC/TC-2095 with the 10 MΩ 

resistor networks supplied in the kit. The 10 MΩ resistor networks allow 

the signal to be ground-referenced or floating. Channels with open 

thermocouples saturate at all sample rates.

Use long-nose pliers to remove or replace the resistor networks in the 

sockets. Be careful not to damage the network package. Make sure pin 1 

of each network is in the correct socket. Refer to Figures 6 and 7 as needed.

Table 5.  Channel Input Signals and Resistor Network

Channel

Pull-Up Resistor 

Network

Ground-Referencing 

Resistor Network

<0...7> RP8 RP4

<8...15> RP7 RP3

<16...23> RP6 RP2

<24...31> RP5 RP1

CH+

CH–

CH+

CH–

SCXI Module or VXI-SC Submodule

Rpull-up

(RP5, RP6, RP7, RP8)

Rground referencing

(RP1, RP2, RP3, RP4)
(in sockets)

Screw Terminals

5 V

Pull-Up Switch

Ground Referencing
 Switch
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Figure 6.  Resistor Networks

Figure 7.  Pin 1 Location on BNC/TC-2095 for Ground-Referencing Resistor Socket

Each resistor network is labeled with descriptive numbers on the left front 

side, and pin 1 is located directly beneath the darkened symbol within these 

numbers. The 10 Ω resistor network is labeled 10x-1-100 (10 × 100 Ω); the 

10 MΩ resistor network is labeled 10x-1-106 (10 × 106 Ω). Figure 6 shows 

examples of these resistors.

SCXI-1100 Module
For the open thermocouple channel to saturate without disturbing the 

measurements on any other channel, use an interchannel delay of 200 µs 

or greater at a gain of 100 or higher, which corresponds to a sample rate 

of 5 kHz.

After installing the 10 Ω bias resistors, you can accurately measure at the 

maximum sampling rate of the module. The open thermocouple channel 

may not saturate if the interchannel delay is less than 200 µs or if the 

sample rate is more than 5 kHz at a gain of 100 or higher.

If you want fast open thermocouple detection and you have short 

thermocouple leads, or if high accuracy is not important, you can replace 

the pull-up resistors with a lower value resistor network. For example, 

you can replace the pull-up resistor with a 1 MΩ, 10-pin bused 

configuration resistor network (not included) and have a sample rate of 

20 kHz, with an interchannel delay of 50 µs typical. With a 1 MΩ bias 

resistor network, the current leakage would be 5 µA (5 VDC ÷ 1 MΩ), 

which can result in a larger offset error because of thermocouple lead 

resistance.

Use long-nose pliers to remove or replace the resistor networks in the 

sockets. Be careful not to damage the network package. Make sure that 

pin 1 of each network is in the correct socket.

Mfr. code
10x-1-106

Pin 1

Mfr. code
10x-1-100

Pin 1

a. 10 Ω Resistor Network b. 10 MΩ Resistor Network

Pin 1

RP1
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Errors Due to Open-Thermocouple Detection Circuitry
Open-thermocouple detection circuitry can cause two types of 

measurement errors. These errors are the results of common-mode voltage 

at the input of the SCXI module and current leakage into the signal leads.

Common-Mode Voltage at the Input of the 
SCXI Module
With 10 MΩ pull-up and bias resistors, a common-mode voltage of 

2.5 VDC develops if the thermocouple is floating. At a gain of 100, the 

common-mode rejection of the SCXI-1102/B/C module is sufficiently high 

that the resulting offset error is negligible.

If the application demands extremely high accuracy, you can eliminate this 

offset error by calibrating the system with both the pull-up and 

ground-referencing resistor switches ON. You also can turn off the pull-up 

resistor switch, which eliminates the open-thermocouple detection feature, 

or use the 10 Ω ground-referencing resistor networks, which brings the 

common-mode voltage down to nearly 0 VDC.

Current Leakage
The open-thermocouple detection circuitry results in a small current 

leakage into the thermocouple. With the 10 MΩ bias and pull-up resistor 

networks, the current leakage results in a negligible error. With the 

10 Ω bias resistor, the 10 MΩ pull-up resistor connected to 5 VDC causes 

a current leakage of approximately 0.5 µA (5 VDC/10 MΩ) to flow into the 

unbroken thermocouple.

If the thermocouple is lengthy, a voltage drop develops in the thermocouple 

because of lead resistance. For example, if you have a 24 AWG J-type 

thermocouple that is 20 feet long, a voltage drop of approximately 8 µV 

can develop in the thermocouple, which corresponds to an error of 0.18 °C 

according to the following equation:

Voltage drop value = (0.145 Ω/ft + 0.658 Ω/ft) × 20 ft × 0.5 µA

If the application demands high accuracy, you can eliminate the voltage 

drop inaccuracy error by turning off the appropriate pull-up resistor 

network or by calibrating the system offset. For the location of these 

switches, refer to Figure 3.
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Specifications

All specifications are typical at 25 °C, unless otherwise specified.

Electrical
Cold-junction sensor (TC-2095 Only)

Accuracy1........................................ 0.65° from 15 to 35 °C

1.0° from 0 to 15 °C 

and 35 to 55 °C

Repeatability ................................... 0.35° from 15 to 35 °C

Output ............................................. 1.91 (at 0 °C) to 0.58 VDC 

(at 55 °C)

Open-thermocouple detection

Pull-up resistor ................................ 10 MΩ

Ground-referencing resistor ............ 10 Ω default or 10 MΩ

Physical
Dimensions ..................................... 48.3 cm by 4.4 cm by 19.0 cm

(19.0 in. by 1.7 in. by 7.7 in.)

Maximum Working Voltage
Maximum working voltage

(signal + common mode) ....................... Each input should remain 

within ±10 VDC of chassis 

ground

Environmental
Operating temperature............................ 0 to 50 °C

Storage temperature ............................... –20 to 70 °C 

Humidity ................................................ 10 to 90% RH, noncondensing

Maximum altitude .................................. 2,000 m

Pollution Degree (indoor use only) ........ 2

1   Includes the combined effects of the temperature sensor accuracy and the temperature difference between the temperature 
sensor and any screw terminal. The temperature sensor accuracy includes tolerances in all component values, the effect caused 
by temperature and loading, and self-heating.
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Safety
This product is designed to meet the requirements of the following 

standards of safety for electrical equipment for measurement, control, 

and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 3111-1, UL 61010B-01

• CAN/CSA C22.2 No. 1010.1

Note For UL and other safety certifications, refer to the product label, or visit 

ni.com/hardref.nsf, search by model number or product line, and click the 

appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997+A2:2001, 

Table 1

EMC/EMI ...............................................CE, C-Tick, and FCC Part 15

(Class A) Compliant

Note For EMC compliance, you must operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 

directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility

Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 

regulatory compliance information. To obtain the DoC for this product, visit 

ni.com/hardref.nsf, search by model number or product line, and click the 

appropriate link in the Certification column.



National Instruments™, NI™, ni.com™, and SCXI™ are trademarks of National Instruments 
Corporation. Product and company names mentioned herein are trademarks or trade names of their 
respective companies. For patents covering National Instruments products, refer to the appropriate 
location: Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.

© 1999–2003 National Instruments Corp. All rights reserved.
321731B-01 Oct03

*321731B-01*


	BNC/ TC-2095 Rack-Mount Adapter Installation Guide
	Conventions
	What You Need To Get Started
	Connecting Signals
	Connecting Field Signals
	Configuring Open-Thermocouple/Signal Detection and Signal Ground-Referencing
	Table 1. Configuring Open-Thermocouple/Signal Detection and Signal Ground-Referencing

	Connecting the BNC/TC-2095 to the SCXI Module
	Figure 1. Connecting the SH96-96 Cable to the SCXI Module
	Figure 2. BNC/TC-2095 Connected to SCXI Module


	Configuring the BNC/TC-2095
	Figure 3. BNC-2095 Parts Locator Diagram
	Configuring the Shield Ground Jumper
	Table 2. BNC/TC-2095 Shield Ground Jumper Configuration


	Configuring the Cold-Junction Sensor (TC-2095 Only)
	Table 3. Jumper W1 Settings for the TC-2095
	Temperature Sensor Output and Accuracy
	Table 4. Temperature Sensor Voltage Output Accuracy

	Temperature Sensor Circuit Diagram
	Figure 4. Temperature Sensor Circuit Diagram


	Configuring the Resistor Networks
	Figure 5. Resistor Connections
	Table 5. Channel Input Signals and Resistor Network
	SCXI-1102/B/C Module
	Figure 6. Resistor Networks
	Figure 7. Pin 1 Location on BNC/TC-2095 for Ground-Referencing Resistor Socket
	SCXI-1100 Module
	Errors Due to Open-Thermocouple Detection Circuitry
	Common-Mode Voltage at the Input of the SCXI Module
	Current Leakage


	Specifications
	Electrical
	Physical
	Maximum Working Voltage
	Environmental
	Safety
	Electromagnetic Compatibility
	CE Compliance


